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Introduction
The Boson Exam Environment™ (BEE™) is a software application that is used by Boson Software
and Marketplace authors to deliver practice exams in an exam simulation environment. When you start
the BEE, you should note that it can store multiple exams from multiple sources. If you have already
downloaded at least one exam, the BEE opens the Exam Selection panel; if you have not downloaded
any exams, the Exam Wizards dialog box will open. The Exam Selection panel is shown below:

On the Exam Selection panel, you can select the My Exams tab, the My Downloads tab, the Get
Demos tab, and the Saved Exams tab. The My Exams tab is open by default and displays all of your
downloaded exams from all vendors. From this panel, you can also access the following:
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•

Choose Exam – This will open the Exam Selection panel if you do not already have it open;
if you have clicked the Exam Tools button or have clicked the Load Exam button and want to
return to the Exam Selection panel, you should click the Choose Exam button to return to the
Exam Selection panel. If the Exam Selection panel is already open, this will not change your
view.

•

Exam Wizards – This enables you to take, activate, or download an exam.

•

Exam Tools – This contains tools that can be used to update a downloaded exam, update the
BEE software, download an activated exam, or remove a downloaded exam from your computer.

•

Settings – This contains options that allow you to configure the display, network settings, font,
appearance, and miscellaneous items related to the exam environment.

•

About – This displays information about the BEE version and the license agreement.

•

Help – This directs you to the document you are reading now and provides you with support
information.

•

Load Exam – This opens the Exam Settings panel and enables you to begin the selected exam.
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•

Send Feedback – This option, which is also available from multiple locations within the BEE,
provides a way for you to contact us. Please use this to tell us how you liked the software,
whether you are experiencing difficulties, or any questions you might have about an exam. If you
have questions about a specific question in an exam, click Feedback from the menu bar while
you are viewing that question so that the support ticket is directed to the correct author or book
publisher.

Prior to loading an exam, you should verify that the name and email address displayed next to Welcome
at the bottom of the window is the one associated with your Boson.com account. If it is not, click the link
and choose the appropriate option from the Account Login dialog box.

Using the Boson Exam Environment to Prepare for Your
Certification
There are many ways to learn the technology for your certification exam. You can read books, attend
training classes, get real-world experience, and evaluate your knowledge and preparation by taking
practice exams. The Boson ExSim-Max practice exams delivered by the BEE include the topics covered,
the question types, and the question difficulty that you would see on the live exam. Additionally, the
practice exams are configured so that you can take them in Simulation Mode, which simulates the time
allowed by the real exam and the ability to navigate back and forth between questions if allowed by the
real exam.
But the ExSim-Max practice exams go above and beyond simulating the question type and difficulty of the
live exams—they also include accurate and detailed explanations for each question. You not only learn
the correct answer for each question, you learn why that answer is correct and why the other answers are
incorrect, and you learn the technologies and concepts covered in the exam.
The BEE has a wide variety of settings you can use to customize your learning experience so that you
can get the most out of your study time. You can use Study Mode or Simulation Mode, you can create
a Random Exam, you can take a Custom Exam that contains questions related to a specific topic, and
much more.
To learn how to download the BEE, install the BEE, and activate products on your computer and begin
taking practice exams, visit the appropriate sections in this document.

Getting the Most from Boson ExSim-Max
Boson ExSim-Max practice exams are the most comprehensive simulation products on the market. When
you take an ExSim-Max exam in the BEE, you can prepare for your certification by simulating the real
exam. More information about each of the following steps is given later in this manual, but if you want to
be prepared for a real exam, you should purchase, download, and take an ExSim-Max exam. Once it is
downloaded, you can take an ExSim-Max exam by following the steps below:
1. Select the product covering the exam you are preparing for, and click Load Exam.
2. In the Exam Settings panel, select Exam A and Study Mode.
3. Click Modify Settings, and ensure that the option in the drop-down list box below Show
answers and explanations is either When I choose ‘Show Answer’ (default) or Never.
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4. Click Done, and then click Begin. While you are taking the exam, try not to look at the
explanations; move from question to question as you would in a live exam.
5. After you have completed the exam, click End and Grade to view your score report and to see
what areas you need to improve upon.
6. Review the questions and detailed explanations provided for all of the questions in the exam. The
explanations and references will cover nuances that can help you better understand the material.
7. Use the references provided and, at a minimum, study the topics that you feel will assist you in
improving your chances of passing the live exam.
8. When you think you are ready to take the next step, select Exam B and Study Mode from the
Exam Settings panel, and repeat steps 3 through 6.
9. If you do not pass Exam B, repeat steps 6 through 8 and retake exams A and B. You should wait
to take Exam C until you have become very familiar with the topics and concepts evaluated in
Exams A and B.
10. If you do pass Exams A and B, you can take a random exam prior to taking Exam C to increase
your knowledge of the required material.
11. Finally, take Exam C in Simulation Mode to evaluate your readiness to take the live exam.
When you can pass all the practice exams in the product and have studied the topics and concepts
contained in the references and explanations, you should be ready for the live exam.

Supported Question Types
The BEE supports multiple types of questions so that it can accurately simulate the live exam
environment. Depending on the exam you choose, the exam vendor, and the exam author, you might
see any, all, or a combination of the question types listed below. ExSim-Max practice exams are written
to mirror the live exam, so the question types you see in an ExSim-Max practice exam are likely the ones
you will see in the live exam.

3

•

Multiple Choice – single answer
Make one selection from the available choices.

•

Multiple Choice – multiple answer
Make more than one selection from the available choices.

•

Multiple Choice – part of the solution
Make one or more selections from the available choices; each choice on its own is part of the
solution, and all answers combined present the entire solution.

•

Multiple Choice – complete solution
Make one or more selections from the available choices; each choice on its own is a complete
solution.

•

Drag-and-Drop
Drag boxes from one location on your screen to another. Typically, you are asked to drag terms
onto their corresponding definitions or into their proper categories. You might also be asked to
drag items onto a network diagram.

Boson BEE User Manual

•

Boson NetSimX Simulation
Configure one or more Cisco devices, including routers, switches, and other devices. The BEE
supports Cisco IOS®-based simulations using the Boson NetSimX Cisco IOS simulator and
supports GUI-based simulations such as the Cisco SDM and the new Cisco TSHOOT simulator.
All of the commands and features of live Cisco equipment might be available, but the commands
you need to complete the simulation will be available.

•

Testlet
Answer multiple questions (typically no more than six and typically multiple choice) that are all
based on a common scenario or network topology. You will be shown any required command
output in the scenario text. You can answer the testlet questions in any order, but once you leave
the testlet, you cannot return to it on the live exam or in Simulation Mode in the BEE.

•

Simlet
Answer multiple questions (typically no more than six and typically multiple choice) that are all
based on a common scenario or network topology; this is a combination of a simulation and
a testlet. Like a testlet, you will answer multiple questions; however, you will not be provided
any command output. Instead, you must interact with the network devices through the Boson
NetSimX Cisco IOS simulator and issue the proper commands to be able to answer the questions
correctly. All of the commands and features of live Cisco equipment might not be available, but
the commands you need to complete the simlet will be available.

•

Fill-in-the-blank
Type your response into one or more text boxes.

Note: This is only a partial list of question types supported by the BEE.

Exam Authors/Content Writers
The BEE can be used to deliver content from multiple authors. For example, practice exams created,
supported, and published by Boson staff authors are all displayed within the ExSim-Max Exams
category. Marketplace exams are written, edited, and supported by independent authors and displayed in
the Marketplace Exams category. These authors are generally subject matter experts who wish to share
their knowledge about a subject. Content-related feedback submitted from the BEE is sent to the author
of the product. Software-related feedback submitted from the BEE is sent to Boson Software.
The BEE is not limited to delivering exams for IT certification. In fact, it can be used to deliver virtually any
type of exam.
The author of a Marketplace exam is displayed when the exam in the About the Exam dialog box. The
About the Exam dialog box can be accesses by clicking the info icon ( ) next to the exam’s title or by
clicking Help > About Exam Name. Similar information is available for book reviews. If you are interested
in writing a practice exam and using the BEE to publish your content, please contact us.

Getting Started
System Requirements
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The system requirements for the BEE are as follows:
•

Supported Operating Systems: Windows 10, Windows 8, Windows 7, Windows Vista

•

.NET Framework: Microsoft .NET Framework Version 4.5

•

Processor: 1-GHz Pentium processor or equivalent (Minimum); 3-GHz Pentium processor or
equivalent (Recommended)

•

RAM: 512 MB (Minimum); 2 GB (Recommended)

•

Hard Disk: At least 200 MB of available space

•

Display: 1024 x 768 or higher resolution; 32-bit

•

Active Internet connection

Downloading the BEE
The BEE can be downloaded, for free, from the Downloads page of the Boson.com website or by
following the link in your purchase receipt email. Click the download link, and save the installation file to a
location on your computer where you can easily find it.

Installing the BEE Software
Note: When installing the BEE software, you should temporarily disable your antivirus software and then
re-enable when you have completed the installation.
Once the BEE software has been downloaded to your computer, follow the prompts to complete the
installation. Allow the BEE to install the Microsoft .NET Framework if necessary and create the file
structure it needs to function properly. If you have difficulty with the installation, please contact our support
team.

Activating an Exam
When you purchase an exam product from Boson.com, you will receive an email that contains the
activation key and a link to download the BEE.
Each exam product has a unique activation key; activation keys can be purchased from Boson.com. If
you already have the BEE installed, you do not need to install it again. If you do need to install the BEE,
you should download and install the software from Boson.com to ensure that you have the latest version.
After you purchase the product from Boson.com, you will need to activate and download the exam to your
computer. The following steps are those necessary to purchase a product from Boson.com, activate it,
and then download it to your computer.
1. Create a Boson.com account if you do not already have one.
2. Select and add the desired exam to your Boson.com shopping cart.
3. Follow the steps through the checkout process.
4. Open the receipt email you will receive from Boson. The email will contain your activation key and
a download link for the BEE.
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Note: If you did not receive an email or cannot find the information, you can view your purchase
history by logging in to your Boson.com account.
5. Download and install the BEE if it is not already installed on your computer.
6. Start the BEE software.
7. If you have not previously opened the BEE, you will be asked to log in by using an existing Boson
account or to create a new Boson account. Select the appropriate choice, and click Next.

8. In the Login to Profile Wizard dialog box, enter your Boson.com account credentials and click
Log in.

9. If an update is required, click Update in the dialog box that appears.
10. Click Exam Wizards if the Exam Wizards dialog box does not automatically open.
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11. Select Activate a purchased exam, and click Next; note that an active Internet connection is
required in order to activate or doaload an exam
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12. After you have reviewed the license agreement, select Yes to accept the terms and click Next.
13. Copy the activation key(s) one at a time from the email receipt and paste them into the fields
provided, or carefully type in the activation key found in your book. Click Next.
14. If you entered a valid activation key, click OK at the You have successfully activated your
exam(s) message; otherwise, please verify that the key(s) you entered in the field(s) was not
mistyped.
15. Select the product from the list of successfully activated products, and click Next to download the
exam content.
1. Click Finish.
Your product should now be displayed in the list of exams on the My Exams tab.

Downloading an Activated Exam
Note: You must purchase and activate a product before you can download it unless it is a demo version
of a product.
The BEE is used to download all practice exam products. There are two ways that you can download
products:
A. Use the Wizard displayed during the activation process; the download process using the wizard is
described in Activating an Exam.
B. Open the My Downloads tab. From the My Downloads tab, perform the following steps:
1. Select the product from the list of activated products.
2. Click Download Exam to download the selected product.
Note: You can download multiple selected activated exams at the same time by using the
Ctrl+click combination and clicking Next.
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To begin an exam, see the Loading an Exam section of this document.

Exam Wizards
To access the wizards included with the BEE, you should click Exam Wizards. You can then select to
activate a purchased exam or download a previously activated exam from the Exam Wizards dialog box.

Activate a Purchased Exam Wizard
You can use this option to activate a purchased exam. More information about activating a purchased
exam is in the Activating an Exam section of this document. Selecting this option will require you to accept
the terms of the license agreement and will then open the Activate Exam Wizard dialog box.

1. When prompted, review the license agreement, select Yes to accept the terms, and click Next.
2. Copy the activation key(s) one at a time from your email receipt, and paste the activation key(s)
into the fields provided. Click Next.
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3. If you entered a valid activation key, click OK at the You have successfully activated your
exam(s) message; otherwise, please verify that the key(s) you entered in the field(s) was not
mistyped.
4. Select the product from the list of successfully activated products, and click Next.
5. Click Finish. Your product should now be displayed in the list of exams on the My Exams tab.

Download Practice Exam Wizard
You can use this option to download an activated exam. Selecting this option will open the Download
Activated Exam dialog box.

Click the exam you want to download, and click Next. The exam will be downloaded. Click Finish to
return to the My Exams tab, where your downloaded exam will appear.
For more information about downloading exams, see the Downloading an Activated Exam section.

Choosing an Exam
My Exams Tab
Loading an Exam and Modifying Exam Settings
From the Exam Selection panel, you can select an exam product by double-clicking the exam name or
by selecting an exam and clicking Load Exam. When you click Load Exam, the Exam Settings panel
will open. From the Exam Settings panel, you can select an exam bank, select a test mode, reset the
settings to their defaults, modify additional settings, or begin the exam.
Select an Exam
As described in the Getting the Most from Boson ExSim-Max section, Boson’s ExSim-Max products
have multiple exams within them, each of which closely parallels the topics covered, question types,
question difficulty, and time allowed in the live exam. ExSim-Max products are designed to simulate
the complete exam experience, so you know what to expect.
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Marketplace products are written by independent authors or organizations; these authors are solely
responsible for the content within their respective product(s). These products might include questions,
content, references, or other materials that are developed to review the concepts covered in a book
or for other specific purposes.
In the BEE, when you are selecting an exam, the Custom Exam option enables you to create a
custom exam. By default, all questions from all exam banks in the product are selected when Custom
Exam is selected; however, you can customize the number of questions you wish to take, and you
can choose questions by category, case study, and keyword by clicking Modify Settings.
The Random Exam option creates a custom exam that contains the same number of questions you
will see in any other exam bank included with the product. Typically, the author configures the quantity
of questions on the product to equal the number of questions on the live exam. A random exam is
created from a pool of all the questions in the product, in a random order. You can take a random
exam in either Study Mode or Simulation Mode.
Note: Each exam product has been preconfigured by the author and therefore will have different
options displayed when an exam is selected. You can modify these settings by clicking Modify
Settings. Available settings vary among ExSim-Max and Marketplace products.
Select an Exam Mode
There are two available modes in which you can take an exam: Study Mode and Simulation Mode.
Neither mode is available when you have selected the Custom Exam option.
1. Study Mode – This mode allows you to view answers and explanations while working
through the exam questions and does not have a time limit.
2. Simulation Mode – This mode is configured to simulate the live exam and has a time limit.
You will not be able to view the correct answers or explanations in this mode.
Note: Simulation mode is available for ExSim-Max and Marketplace products; In addition, it is
not available for a custom exam.
Reset Settings
This option resets the exam settings to their default configurations.
Modify Settings
This feature has the following settings that allow you to customize your exam experience while in
Study Mode.
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Note: Not all settings are available for all exams.
1. Randomize question order – This option is selected by default; when it is selected, the
order of all questions in the exam is randomized.
2. Randomize answer order – This option is selected by default; when it is selected, the order
of all answers in the exam is randomized.
3. Timed exam – The options in this drop-down list box enable you to configure whether the
exam is timed.
a. Not timed – This option is selected by default and results in no time limit being assigned
to the exam; exams taken in Simulation Mode are automatically timed.
b. Timed by total time limit – This option enables the timed exam features. The total time
limit allowed by the live exam will appear when this option is selected, but the total
number of minutes can be modified.
4. Show current score during exam – This option is selected by default; when it is selected,
you can see your current score, as a percentage based on the number of questions you have
completed, to be calculated and displayed.
5. Show the number of answers needed to be correct – When selected, this option shows
how many choices must be selected to answer the current question. This information is
displayed in the Question toolbar during the exam; the Question toolbar is shown below with
the current score and the number of answers needed to be correct.
Note: This option is disabled for some question types.
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6. Show answers and explanations – The options in this drop-down list box enable you to
configure when answers and explanations are displayed:
a. When I choose ‘Show Answer’ – This is the default option; when you click Show
Answer while taking an exam, the correct answer and the explanation will be shown.
b. When answered incorrectly – When selected, this option causes the correct answer
and explanation to be displayed only when you have answered a question incorrectly and
have clicked Next.
c.

Always – When selected, this option causes the correct answer and explanation for each
question to be displayed when you click Next.

d. Never – When selected, this option causes the correct answer and explanation to never
be displayed for any question.
7. Enable smart mode – When this option is selected, items that have been answered correctly
will be excluded from the specified exam. You can modify the number of times items must be
answered correctly before they are excluded. The default number is 3.
8. Case Study Settings – The settings on this screen enable you to customize how the case
study feature performs during an exam:

Note: A case study is considered any collection of questions that together have one common
scenario or network topology associated with it. For example, testlets and simlets are
considered case studies and are affected by the settings on this screen.
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a. Display Review Screen – If Yes is selected, the review screen will be displayed when
you click Next after the final question in the case study.
b. Display Confirmation – If Yes is selected, a message box will be displayed requiring
you to confirm that you wish to exit the case study review screen.
Allow Retake – If Yes is selected, you will be allowed to retake previous questions within
a case study.

c.

d. More Case Study Settings (Custom Exam only) – The options on this screen enable
you to select specific case studies and limit the number of questions in the selected
cases.

		
		i.

Available Cases – Cases in this window are not included in your custom exam.

		ii.
		

Selected Cases – Cases in this window will be included in your custom exam,
depending on the Limit total to settings. By default, all cases are selected.

		iii.
		
		
		

Limit total to – You can select the number of case studies to be included in your
custom exam. (The specified number cannot exceed the number of cases.) The
options are those included in the Selected Cases window. The total number of cases
is selected by default.

			1. Cases with a maximum of – This shows how many cases are in the Selected
			Cases window.
			2. Questions each – This enables you to limit the maximum number of questions
			
included in each case in your custom exam. (The specified number cannot
			
exceed the number of questions in the case that includes the highest quantity of
			questions.)
		iv. Reset – This resets the number of cases and questions per case to their defaults.
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		v.

Back – This returns to the Case Study Settings panel.

e. Reset – This resets all case study settings options to their defaults.
f.

Back – This returns to the secondary Exam Settings panel.

9. Category and Keyword Settings (Custom Exam only) – These options enable you to
customize what questions will be included in your custom exam based on what category they
are in or the keywords they contain. Note that the total number of questions that are included
in your custom exam is also displayed on this panel.

Note: When an exam is created, the author assigns each question to a category. These
categories are intended to group questions into topics or concepts covered on the live exam.
Book publishers may group questions into categories according to where the topic is covered
in the book.
a. Available Categories – Categories in this window are not included in your custom exam.
b. Selected Categories – Categories in this window will be included in your custom exam,
depending on other customization settings such as keywords.
c.

Only show questions with these keywords – You can specify words that you want
to use to filter the questions that will be included in your custom exam. Only questions
that contain one or more of these keywords will be included.

d. Back – This returns to the secondary Exam Settings panel.
10. Total number of questions box – This section shows the total number of questions that are
included in the current exam and allows you to configure the total number of questions you
want to include in the custom exam.
11. Done – This returns to the primary Exam Settings panel.
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Note: The settings you configure are product-specific and are stored for that product the next time
you load it into the BEE unless you have loaded another product. For example, if you take an exam
for ExSim-Max for Cisco 200-301 and configure custom settings for that product, those settings will
be stored and used each time you load the exam until you load another product, such as ExSim-Max
for Cisco 350-401. When you load ExSim-Max for Cisco 350-401, that product’s settings will reset to
default values and you can configure custom settings for that product as well. When you load ExSimMax for Cisco 200-301 again, its settings have been returned to the default values and you can
reconfigure custom settings if desired.
Remember that these settings include category and keyword settings as well, so if you have
configured your current exam to show items with the keyword “troubleshoot,” for example, and
only 12 questions in the exam contain that keyword, when you return to that exam without having
loaded another product, you will see only 12 questions. In addition, if you have selected Exam A in
Simulation Mode, when you return to that exam you will see only the items in Exam A and you will be
in Simulation Mode.
Although the settings are stored for a product for as long as you take only that product’s associated
exams, you can change any exam settings if desired and the new settings will be used the next time
you use that same product.
You can see the settings you have configured for each product by reviewing the box at the bottom of
the primary Exam Settings panel. In the exhibit below, you can see the number of questions included
in the custom exam, the keyword selected, the cases included, the settings of each case, and more:
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Begin
When you have selected an exam and configured your desired exam settings, click Begin on the Exam
Settings panel to start your exam. The following list shows the options that are available from the Menu
Bar while you are taking an exam.
1. Menu Bar

a. File – You can select from the following options:
		i. Open Saved Exam – This allows you to select a previously saved exam and load it into
		the BEE.
		ii.

Save – This allows you to save your current exam.

		iii. Save As – This allows you to save your current exam.
		iv. Print – This allows you to print the current question (and explanation if displayed).
		v. Quit to Menu – This closes the current exam and returns you to the Exam Selection
		panel.
		vi. Exit – This exits the BEE software.
b. Exam – You can select from the following options:
		i. Jump to – This allows you to view a specific case study or navigate quickly to a particular
			
question by entering a specific question number or the question ID number and
			clicking Jump.

					

		ii. Question Toolbar – This option hides or displays the current question number, the
		
current score (percentage), the number of answers required for the question, and the
		Mark for review option. The question toolbar is shown in the graphic below:

		iii. Full Screen – This maximizes the BEE window size to fit your monitor.
		iv. Settings – This opens the Application Settings dialog box. See Application Settings
		
for more information.
c.
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Feedback – This opens the Send Feedback dialog box. See Feedback for more information.
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d. Help – You can select from the following options:
About – This displays information about the BEE software and provides access to
the following options:

		i.
		

			1. Version – This shows the version that is currently installed on your computer.
			2. What’s new in the Boson Exam Environment – This shows you the changes
			
included in the newest release of the BEE.
			3. View the License Agreement – This allows you to review the Single User
			License Agreement.
User Manual – This directs you to the document you are reading now.

		ii.

		iii. About (Exam Name) – This displays information such as the exam number, the
		
exam name, the associated certifications, and the author in the About the Exam
		window:

		

		iv. Help for (Exam Name) – If a help document has been written for the product, this
		
option will be available and will open the related help document.
2. Exam Toolbar – This is located at the bottom of the exam window while an exam is in progress;
it allows you to navigate through the exam using the following options (if the settings have been
configured):
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a. Previous – This displays the previous question.
b. Next – This displays the next question.
c.

Show Answer – This displays the correct answer and the explanation for the current
question.

d. Notes – This allows you to make notes about the current question. If you have created a note
for a question, it is stored in the product information and will appear on the top-right corner of
the BEE when you display that question in the BEE. You can open the note by clicking it
and delete the note by clicking del when the note is open.

e. Print – This allows you to print the current question (and the explanation if it is displayed).
f.
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Question Review – This displays the Question Review window. This window contains a list
of the questions in the exam. If you are in a case study, testlet, or simlet, it will display only
those questions with an option to view all questions in the exam. Information about the
questions is displayed in columnar format showing Item (the order in which the question was
displayed during the exam), Answered (whether or not you answered the question during the
exam), Marked (whether or not you marked the question for review), Question (brief text of
the question), Category (the category assigned to the question by the author), ID (the unique
identification number assigned to the question), and QID (the question ID displayed during
the exam. You can select from multiple options in the Question Review dialog box:
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		i.

End and Grade Exam – This ends the exam and displays the Exam Results dialog box.

		ii.

Jump to selected question – This opens the selected question in the BEE.

		iii.
		
		
		

End Cisco Testlet (or End Case Study or End Cisco Simlet) – If you are in a Cisco
testlet, a case study, or a Cisco simlet, this ends the current testlet and displays the next
question in the exam. Note: This option is only displayed when this dialog box is
accessed from within a case study.

		iv. Show all questions – If you are currently in the review screen for a Cisco testlet, case
		
study, or Cisco simlet, you can click this to display all questions in the current exam.
		v. Show scenario questions – If you were in a Cisco testlet, case study, or Cisco simlet
		and clicked Show all questions, this option is available and displays only questions
		
contained in the currently displayed testlet, case study, or simlet.
		vi. Close – This closes the Question Review window and returns to the selected question.
3. Question Status bar – This displays information about your progress in the exam such as the
current exam, the question ID, the number of available questions, the current score (percentage),
and the Mark for review option; if you have selected Mark for review, you will see a check mark
in the Question Review window in the Marked column.

4. Launch Simulator – Simulation, NetSimX, and drag-and-drop type questions will display a
button that launches the simulation so that you can respond to the question type.

My Downloads Tab
To access the My Downloads tab, you should do one of the following:
A. Exit your current exam, and click the My Downloads tab from the Exam Selection panel.
B. Click Choose Exam, and click the My Downloads tab from the Exam Selection panel.
Products that have been activated but not yet downloaded are listed on this tab. You must activate a
product before it will appear on this tab. The BEE is used to download practice exam products and bookreview content. To download activated products listed on this tab, you should perform the following steps:
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1. Select the product from the list of activated products.
2. Click Download Exam to download the selected product.
Note: You can download multiple activated exams at the same time by using the Ctrl+click
combination.
For more information about downloading exams, see the Downloading an Activated Exam section of this
document.

Get Demos Tab
The Get Demos tab displays all ExSim-Max and Marketplace products that have available demos; the
products are listed by exam vendor. You can select any exam from the list and click Download Demo to
preview a sample of the available product.

Saved Exams Tab
The Saved Exams tab lists any exams you have saved to the default saved exam folder. These saved
exams are sorted by exam name and display the date and time they were saved. To load a saved exam,
you should select the exam and click Load Saved Exam. If you saved an exam to a folder other than the
default folder, you can click the Browse button to navigate to it and then load the saved exam into the
BEE.
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Grading an Exam
The Exam Results dialog box can be accessed from multiple locations in the exam by choosing the End
and Grade option.

When the Exam Results dialog box is displayed, the following options are available:
1. Menu Bar Options
a. File – You can select from the following options:
		i.

Save Exam – This option saves your current exam locally to your computer.

		ii.
		
		

Print – This allows you to print your exam results. The printed results will display
information such as your name, the exam name, your score, how well you did on items in
specific categories, and more.

		iii. Quit to Menu – This options closes the Exam Results window and returns to the Exam
		Selection panel.
		iv. Exit – This exits the BEE software.
b. View – You can select options that you want displayed in the dialog box.
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		i. Question Review – You can select or clear the following options you want to appear on
		the Question Review tab:

			a) Item – This is the item number for the question; it denotes the order of the questions
			
as they were displayed during the exam.
			b) ID – This is the unique ID number assigned to the question.
			c) QID – This is the author-assigned question ID number.
			d) Question – This is a snippet of the text of the question.
			e) Category – This is the author-assigned category.
			f)

Difficulty Level – This is the author-assigned difficulty level.

			g) Question Type – This is the type of question.
			h) Answered – This shows whether you answered the question.
			i)

Marked – This shows whether you marked this question for review.

			j)

Score – This displays whether you answered the question correctly or incorrectly.

		ii. Category Review – You can select or clear the following options you want to appear on
		the Category Review tab:

			a) Category – This shows the author-assigned category.
			b) Total – This shows the total number of questions in the category.
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			c) Score – This shows the percentage of questions that you answered correctly in each
			category.
c.

Feedback – This opens the Send Feedback dialog box. See Feedback for more information.

2. Exam Information tabs – Several tabs are displayed in the Exam Results dialog box that you
can use to gauge the progress of your ability to pass the live exam.
a. Overall tab – This displays your result, your current score, and the passing score.

b. Category Breakdown tab – This displays the categories in the exam and your results within
each category.
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c.

Question Review tab – This displays information about each question and how it was scored
in the exam.

d. Category Review tab – This displays the exam categories and lists the number of questions
assigned to each category; it also shows the percentage of questions answered correctly.

e. References tab – This displays a list of references included in the exam, sorted by question.
You can click categories to include or omit their associated questions from the list.
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3. Navigation Bar Options – You can select from the options below to perform specific tasks.

a. Retake incorrect questions – This restarts the exam at the first incorrect question and
allows you to navigate through incorrect questions and review the explanations.
b. Submit Exam Score – This stores your graded exam on Boson.com servers so that you can
compare your results when taking the same exam again.
c.

View Submitted Scores – This compares your stored exam grades with your current exam
grade so that you can evaluate your learning progress.

d. Exit Exam – This exits the current exam and returns to the Exam Selection panel.

Exam Tools
The Exam Tools panel is shown below:
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Update Exam
This option downloads all files associated with a selected exam product to ensure that you have the most
up-to-date copy of the product. To use this tool, you should first click the Choose Exam button and select
from the Exam Selection panel the exam product that you want to update. Then click Exam Tools >
Update Exam. You will be asked to provide the email address and password associated with your Boson.
com account. After entering your information, click Log in to download and update the selected exam.
Note: This tool does not look for available incremental updates. Instead, it downloads the entire exam
each time the tool is used. You will receive a notification when incremental exam updates are released
when you load an exam if Internet access is available.

Update BEE
This option checks for available updates for the BEE software and NetSimX simulator and applies all
available updates. You can also update the BEE from the Windows Start menu by clicking Start > All
Programs > Boson Software > Boson Exam Environment > Boson Application Update.
Note: You will be prompted to update the BEE if incremental updates are available when the BEE is
launched.

Unlock Exam
This option starts the Activate a Purchased Exam Wizard.

Run BEE Cleaner
The BEE cleaner is a tool that removes support files associated with the BEE and your downloaded
exams. You can choose to remove user profile data, downloaded exams, and/or saved exams.
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When you are done in the Exam Tools panel, click Done to return to the Exam Selection panel.

Application Settings
To access this dialog box, you should click the Settings button after the BEE is loaded. This dialog box
allows you to configure exam environment settings.

General Tab
The settings on this tab are used to configure network connectivity, file association, how exams are
displayed on the My Exams tab, and the appearance of alert messages.

Network Settings
1. Automatically check for updates on startup (Recommended) – This option causes the BEE
software to search for updates each time the software is loaded. Updates are not automatically
installed or downloaded. You will receive a prompt to apply any available updates when an
update is available. This option is enabled by default.
2. Proxy Configuration – This displays the Proxy Settings Configuration dialog box. You should
use this form only if your computer requires the use of proxy settings to access the Internet.

Miscellaneous
1. My Exams Tab – This setting determines how your list of downloaded exams is displayed on the
My Exams tab.
a. Automatically Group – This option, enabled by default, groups exams by exam vendor
(ExSim-Max, Marketplace, etc.) and then by exam name.
b. Allow Manual Filtering – This option groups exams by certification; it also allows you to
show or hide exams by a specific vendor.
2. Associate the (.exm) file type with this program – This option associates the .exm file type
with the BEE so that, when a file with an .exm file extension is double-clicked from its location,
the file is opened with the BEE software.
3. Warning and Informational Messages – This option resets alert message that were hidden;
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when specific alert messages are displayed, you can choose to hide them and similar messages,
but this option configures the messages to appear when relevant.
When you have configured your desired application settings, click Apply. You can configure additional
settings on the Appearance, Exam Settings, and Privacy tabs. When you are done configuring settings
on all tabs, click OK to close the Application Settings dialog box.

Appearance Tab
The settings on this tab are used to configure the BEE window color, font type, and font size.

Display Settings
1. Preset Styles – This option enables you to choose from several preset color palettes, the default
color style, or a custom color palette from the drop-down list box.
2. Color choices – This section enables you to select a custom color palette for text, background,
and gradients in the BEE. To configure the custom color palette, click a displayed color, choose
the desired color from the resulting Color dialog box, and click OK to apply the selected color.

Font Settings
Choose from one of the available fonts and font sizes. This setting is used to configure how text will be
displayed during an exam.
When you have configured your desired application settings, click Apply. You can configure additional
settings on the General, Exam Settings, and Privacy tabs. When you are done configuring settings on
all tabs, click OK to close the Application Settings dialog box.

Exam Settings Tab
The settings on this tab are used to configure the appearance of multiple-choice question numbering, the
appearance of exhibits and graphics, and the prompts to save an exam.
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Exam Simulation Settings
1. Answers should be labeled with – This option enables you to select letters, numbers, or no
label for each choice.
2. Diagrams default to thumbnail size – This option is enabled by default.
3. Exhibits default to collapsed – This option is enabled by default.
4. Ask me to save my exam progress before exiting an exam – This option is enabled by default.
If you clear the check box, you can still save any exam but you will not be prompted before you
exit an exam.
When you have configured your desired application settings, click Apply. You can configure additional
settings on the General and Appearance tabs. When you are done configuring settings on all tabs, click
OK to close the Application Settings dialog box.

Privacy Tab
The setting on this tab is used to allow or disable the collection of information in order to personalize your
experience and improve Boson software.
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Improve my experience by sharing usage data of this software. (Recommended) – This option
enables you to enable or disable the connection of information regarding your usage of the BEE.
When you have configured your desired application settings, click Apply. You can configure additional
settings on the General, Appearance, and Exam Settings tabs. When you are done configuring settings
on all tabs, click OK to close the Application Settings dialog box.
When you have configured your desired application settings, click Apply. You can configure additional
settings on the General and Appearance tabs. When you are done configuring settings on all tabs, click
OK to close the Application Settings dialog box.

About the Exam
An About the Exam window can be accessed for an individual exam. To open the About the Exam
window, you can click the Exam Info button on the left menu bar or you can click the info icon ( ) next to
the exam name on the My Exams tab of the Exam Selection panel.
The About the Exam window contains the exam number, the exam name, the associated certifications,
and the author. Any additional information about the exam will be appended after this information. You can
also view the exam history and current version from this window. The About the Exam window from the
ExSim-Max for Cisco 200-301 exam is shown below:
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If the exam has a help document associated with it, you can click the help icon ( ) next to the exam
name on the My Exams tab of the Exam Selection panel. You can also click the Exam Help button in
the About the Exam dialog box. The exam’s help document will open in a new window, and you can use
it to review additional information about the exam.

About the BEE Software
When an exam is loaded, you can view information about the BEE by clicking Help > About from the File
menu. This displays information about the BEE version and the license agreement and provides access
to online support topics.

Boson NetSimX Cisco IOS Network Simulator
The Boson NetSimX Cisco IOS network simulator is the platform for delivering simlet and testlet
questions. Simlet questions require you to issue commands to configure simulated Cisco devices; testlet
questions require you to examine various devices’ configurations and answer questions based on those
configurations. The simulator loads within the scenario section of the BEE after you click the Launch
Simulator button.

Boson NetSimX Simulations
1. Click the Launch Simulator button to load the simulation.
2. When the simulation has loaded, you will see general information about the simulator and the item’s
topology. You can scroll down to see all the information and to access the Hide Topology / Show
Topology button. This button enables you to switch between the topology diagram and a device’s
console window. It also enables you to switch between devices if you need to configure or examine
multiple devices in order to complete the tasks required in the simulation.
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3. Access the console of the necessary device(s) by either clicking an available device on the topology
diagram or clicking the Hide Topology button.
4. In the console window, issue the commands necessary to configure the device. The instructions in
the scenario should describe the actions you need to perform to properly configure the appropriate
devices.
5. To access the console of another device, click the Show Topology button and then click the icon of
the next device you want to configure. Note that clicking a device to which you have console access
will switch the screen from the topology diagram to the console window.
6. In the console window, issue the commands necessary to configure the device.
7. When you have configured all devices required by the simulation, click Show Answer or Next.
Note: If, after you have completed the simulation item and advanced to the next item in the exam, you
decide to return to the simulation item and relaunch the simulator, you will be asked to confirm that you
want to reopen the simulation; if you select Yes, your currently saved answer will be reset and you will be
required to begin the simulation item from scratch.

Boson NetSimX Simlets
1. Click the Launch Simulator button to load the simulation.
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2. When the simulation has loaded, you will see general information about the simulator and the item’s
topology on the top half of the screen; on the bottom half of the screen, you will see the questions
associated with the simulation. In the simulation, you can scroll down to access the Hide Topology
/ Show Topology button. This button enables you to switch between the topology diagram and a
device’s console window. It also enables you to switch between devices if you need to configure or
examine multiple devices in order to complete the question.

3. Access the console of the necessary device(s) by either clicking an available device on the topology
diagram or clicking the Hide Topology button.
4. In the console window, configure or examine the configuration of the item as required by the item’s
instructions.
5. To access the console of another device, click the Show Topology button and then click the icon of
the next device you want to configure. Note that clicking a device to which you have console access
will switch the screen from the topology diagram to the console window.
6. Answer the related items.
7. Click Next to proceed to the next question in the simlet, or click the button of the question number
you intend to answer next.
8. When you have answered the related items, end the simulation and continue with the next item in the
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exam by clicking Next, clicking the End Cisco Simlet button if necessary, and confirming that you
want to end the simulation if necessary.

Feedback
The Send Feedback dialog box can be accessed from multiple locations within the BEE, including the
Feedback option on the File menu from within an exam.

You can use this dialog box to submit different types of feedback:
•

Select Exam Content to send feedback or a request to the author.

•

Select Software Features to submit feedback or a feature request to Boson Software.

•

Select Other to submit feedback of a general nature.

When using the Feedback feature, please provide as much information as possible. When you use this
feature, a screenshot and information about your operating system are sent with the feedback request.
If you want to see the additional information sent to Boson Software, you should click View report data.
Prior to submitting a feedback request for support, you should consider viewing common support topics
by clicking Support Topics (Online).
Click Send to submit your detailed feedback, or click Cancel to cancel.

Troubleshooting
Why are some files, images, or exhibits missing from my exam?
Files occasionally become corrupt during the download process. To restore missing files, images, or
exhibits, please update the exam product. To update the exam product, you should follow the instructions
in the Update Exam section of this document. If the files are still missing, please navigate to the affected
question and click Feedback to make the author aware of the issue.
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Error: “Command set failed to load”
Solution 1:
If you receive the error message “Command set failed to load” when starting the NetSimX simulator,
please restart the program by right-clicking the icon you use to start the program and selecting Run as
administrator.
Solution 2:
1. Shut down any Boson applications.
2. Open Add or Remove Programs in Control Panel, and note which version of the Microsoft .NET
Framework is on your computer. If it is not version 4.5, download the program and the service
pack; you can do so from the following link:
Microsoft .NET Framework 4.5
3. Download the Boson registry assembly tool from the following link:
Boson Assembly Registration Tool
4. Run the registry assembly tool, and select the appropriate version from the Microsoft .NET
Version drop-down list.
5. In the Interop Assembly field, browse for the following file:
C:\Program Files\Boson Software\Boson Practice Tests\NetsimXv7\BosonNetsimInterop.dll
6. Click Unregister Interop Assembly, and then click Register Interop Assembly.
7. Restart the practice exam, and try to launch the simulation question again.
Note: If neither Solution 1 nor Solution 2 resolves the problem, please navigate to the affected question
and click Feedback to make the author aware of the issue.

How can I completely remove the BEE and all exams from my
computer?
If a file has become corrupted, you might need to uninstall and reinstall the BEE and the associated
exams. If you do need to uninstall the BEE, follow the steps below. When you are ready to reinstall, see
the Downloading the BEE and Installing the BEE Software sections in this document.
1. From Add or Remove Programs in Control Panel, uninstall the Boson Exam Environment (BEE)
software.
2. Delete the following folders:
Windows 10, Windows 8, Windows 7, and Windows Vista
C:\Program Files (x86)\Boson Software\Boson Practice Exam Environment
C:\ProgramData\Boson Software\Boson Exam Environment
and
C:\ProgramData\Boson
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I saved an exam; why is it not displayed in the list on the My
Saved Exams tab?
If you saved an exam outside of the default location, it might not be displayed in the My Saved Exams
tab within the BEE. You should move your saved exams back to the default location so that you can open
them from the My Saved Exams tab.
The default location for Windows 10, Windows 8, Windows 7, and Windows Vista is C:\ProgramData\
Boson\Profiles\youremail@address.

Contact Information
EMAIL:

support@boson.com

PHONE:

877-333-EXAM (3926)
615-889-0121

ADDRESS:

25 Century Blvd. Ste. 500
Nashville, TN 37214

Copyright © 2004–2020 Boson Software, LLC. All rights reserved. Boson Exam Environment (BEE) and
NetSimX software and documentation are protected by copyright law.

BEE and Boson NetSimX Technical Support
•

To review NetSim support topics, go to the NetSim Products Support Topics page.

•

To submit a support ticket, go to Boson’s website > log in to your account > click Support Tickets
tab > start a new ticket.

•

To submit feedback about a question while the exam is open, click Feedback and include more
information about the specific question or explanation.

License Solutions
•

Single-User License Agreement – You can review the Single-User License Agreement here.

•

Volume Licensing – For our unique license-server solutions and volume discounts, contact us at
Boson.com, 877.333.EXAM or support@boson.com.

Copyright © 2004-2020 Boson Software, LLC. All rights reserved. BEE, NetSim software, and all documentation are protected by copyright law.
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